
Chapter 3

Assembling 
Sequences in the

Timeline
 Learning Objectives 
After completing this chapter, you will be able to:
• Organize assets in the Project panel
• Create a new sequence based on the specifications of a clip
• View clips in the Source Monitor
• Set the numbered and unnumbered markers
• Set the Source In and Source Out points
• Add clips to a sequence
• Add clips using the Overlay and Insert edits
• Use the Toggle Sync Lock and Toggle Track Lock buttons
• Perform the three-point Overlay and Insert edits



3-2			                             Adobe Premiere Pro CS5.5: A Tutorial Approach
E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Tutorial Description
In this tutorial, you will learn how to view clips in the Source Monitor, assemble a sequence 
by dragging clips in the Timeline panel, set markers, set the In and Out points, and perform 
Overlay and Insert edits. Also, you will learn three-point editing with monitor controls.

Downloading Files
Before you start the tutorial, you need to download the c03_premiere_cs5.5_tut.zip file from 
http://www.cadcim.com. The path of the file is as follows:

Textbooks > Animation and Visual Effects > Adobe Premiere Pro > Adobe Premiere Pro CS5.5: A 
Tutorial Approach

Next, extract the contents of the zipped file to \Documents\Adobe Premiere Tutorials.

Creating a New Project
1.	 Start Premiere; the Welcome to Adobe Premiere Pro dialog box is displayed. 

2.	 Choose the New Project button; the New Project dialog box is displayed.

3.	 In the General tab of the New Project dialog box, type chapter03 in the Name text 
box.  

4.	 In the Location area, browse to \Documents\Adobe Premiere Tutorials.

5.	 Choose the Scratch Disks tab. In the Captured Video, Captured Audio, Video Previews, 
and Audio Previews areas, select the Same as Project option from the drop-down lists. 

6.	 Choose the OK button in the New Project dialog box; the New Sequence dialog box is 
displayed. Also, the file is saved with the name chapter03.prproj. 

7.	 Select the default preset settings displayed in the Available Presets area. Make sure that 
the Sequence 01 name is displayed in the Sequence Name text box and choose the OK 
button; the chapter03 file is displayed, as shown in Figure 3-1.

Importing Video Clips
1.	 Press the CTRL+I keys on the keyboard; the Import dialog box is displayed.

2.	 Browse to \Documents\Adobe Premiere Tutorials\Media\Video\Norway and then select the road 
drive (1).AVI clip from it. Next, choose the Open button; the selected file is imported 
and displayed in the Project panel.

	 Next, you will import multiple media files.

3.	 Double-click on the empty area in the Project panel; the Import dialog box is 
displayed.
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Figure 3-1  The chapter03 file displayed

4.	 Browse to \Documents\Adobe Premiere Tutorials\Media\Video\Norway. Next, press CTRL+A to 
select all media files and then hold down CTRL and click on the road drive (1).AVI clip 
to remove it from the selection.

5.	 Choose the Open button; all selected media files in the Norway folder are imported and 
displayed in the Project panel, as shown in Figure 3-2.	

Organizing Video Clips in the Project Panel
1.	 Choose the New Bin button at the bottom of the Project panel; a new bin is created 

in the Project panel. Modify its name to sea clips.

2.	 Select all sea clips in the Project panel by pressing the CTRL key and then drag them to 
the sea clips bin; all selected files are moved into the sea clips bin.

3.	 Click on the empty area in the Project panel to deselect the files. 

4.	 Create a new bin with the name road clips and move all road clips to it. All clips are organized 
in the Project panel, as shown in Figure 3-3. 

Creating a New Sequence
In this section, you will learn to create a new sequence based on the settings of your clips or 
footage in the Project panel.
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Figure 3-2  All clips in the Project panel Figure 3-3  All clips arranged in bins in the 
Project panel

1.	 Select water fall.AVI in the Project panel; the preview of the clip and its specifications 
are displayed on the top of the Project panel, as shown in Figure 3-4. 

Figure 3-4  The preview and settings of the 
selected clip

2.	 Choose the New Item button at the bottom of the Project panel; a flyout is displayed.  
Choose the Sequence option from the flyout; the New Sequence dialog box is 
displayed.

	
	 Next, you need to select one of the presets from the Available Presets area that has almost 

the same settings as that of your footage. 
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3. 	 Accept the default settings in the Sequence Presets tab.

4.	 Choose the Tracks tab from the dialog box; all areas in this tab are displayed. In the Audio 
area, select the Mono option from the Master drop-down list. 

5.	 In the Sequence Name text box, make sure that the Sequence 02 is displayed, and 
then choose the OK button; the Sequence02 is displayed in the Timeline and Project 
panels.

Viewing Clips in the Source Monitor
Now, you need to view the imported clips in the Source Monitor. 

1.	 Double-click on the sea.AVI clip in the Project panel; the clip is displayed in the Source 
Monitor, as shown in Figure 3-5.

Figure 3-5  The sea.AVI clip in the Source Monitor
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	 In the Source Monitor, you can preview the clip, control the playback of the clip, specify 
edit points, trim the video clip, and specify some more viewing options. In other words, 
the Source Monitor allows you to preview the video clip and decide whether you need the 
entire footage or only a part of it to add to the Timeline. 

2.	 Choose the Play-Stop Toggle button from the Source Monitor; the video clip starts 
playing in the Source Monitor. Choose the Play-Stop Toggle button again to stop 
the video clip. You can also press the SPACEBAR key on the keyboard to play and 
stop the video clip. 

3.	 Drag the Shuttle slider to the right; the video clip starts playing forward. Similarly, drag 
the Shuttle slider to the left; the video clip starts playing in the reverse direction. 

	 The speed of playback depends on how far you drag the slider. If you drag the Shuttle 
slider a little bit then the speed of playback will be slow. However, if you drag the Shuttle 
slider a bit farther, then the speed of playback will be faster. 

4.	 Move the cursor over the Jog slider placed just below the Shuttle slider and drag it 
to play the video clip in small increments. The duration of the clip played depends  
on how much you drag the cursor.     

5.	 Choose the Step Forward or Step Backward button to move the video clip one 
frame forward or one frame backward, respectively. Alternatively, press the right 
arrow key on the keyboard to move the video clip one frame forward and press the 
left arrow key to move the video clip one frame backward.

6.	 Press the HOME key to move the CTI at the beginning of the clip and press the END key 
to move the CTI at the end of the clip.

7.	 Press the L key to play the clip forward. Press the J key on the keyboard to play the clip 
backward and press the K key to stop the clip.

8.	 Press the SHIFT+L keys to play the clip forward in slow motion. Similarly, press the 
SHIFT+J keys to play the clip backward in slow motion.

	 The total duration of the video clip is displayed on the top right of the timeruler. Also, 
the current frame time is displayed on the top left of the timeruler, refer to Figure 3-5.

 9.	 Drag the CTI on the timeruler to set the current frame to another time.

10.	 Move the cursor over an end of the time navigator bar and drag it to zoom in the timeruler 
to view it in more detail, refer to Figures 3-5 and 3-6.

11.	 Move the cursor over the current time display; the cursor changes to a hand symbol, as 
shown in Figure 3-7. Next, click on the current time display; it is converted into an edit 
box, as shown in Figure 3-8. Next, type 00:00:03:00; the CTI is moved to that frame, refer 
to Figure 3-9.
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Figure 3-6  The time navigator bar dragged 

Figure 3-7  The cursor changed into a hand symbol

Figure 3-8  The current time display changed to a text box

Figure 3-9  The CTI moved to another frame

12.	 Enter +25 on the current time display; the CTI is now moved 25 frames forward, that is 
at 00:00:03:25, refer to Figure 3-10. Similarly, type -30 on the current time display; the 
CTI is moved 30 frames back, that is at 00:00:02:25.

Figure 3-10  The CTI moved to +25 frames

13.	 Move the cursor over the black down arrow displayed on the right of the Source Monitor 
label, refer to Figure 3-11. Next, click on the down arrow; a drop-down list is displayed, 
showing a list of all the recently opened clips in the Source Monitor, as shown in 
Figure 3-11.

14. Click on the required clip in the drop-down list to reopen it in the Source Monitor. Select 
the Close option; the currently opened clip is closed. You can also select the Close All 
option to close all clips and clear the Source Monitor. 

15.	 In the Project panel, select multiple video clips simultaneously using the SHIFT key. Next, 
drag and drop them to the Source Monitor; the selected clips are listed in the drop-down 
list at the top-left corner of the Source Monitor. Using this list, you can quickly switch to 
the required clip and view it in the Source Monitor.   
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16.	 Click the black down arrow on the right of the Select Zoom Level option; a drop-down 
list is displayed, as shown in Figure 3-12. Now, select the required option to zoom the view 
of the clip in the Source Monitor.

Figure 3-11  Clicking the triangle on the right of 
the Source Monitor label

Figure 3-12  Various zooming options in the 
drop-down list

17.	 Choose the Output button; a flyout is displayed. By default, the Composite Video 
option is chosen. As a result, the video of the clip with the audio is displayed  in 
the Source Monitor. Choose the Audio Waveform option; the audio waveform of 
the video clip is displayed in the Source Monitor, as shown in Figure 3-13. 

Figure 3-13  The audio waveform displayed in the Source Monitor

Setting the Markers in the Source Monitor 
In Premiere, you can set clip markers as well as sequence markers. In this section, you will 
learn how to set the numbered and unnumbered clip markers on the important frames in a 
video clip for further reference.
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Setting the Unnumbered Markers 
1.	 In the Project panel, double-click on water fall.AVI; it is displayed in the Source 

Monitor. 

2.	 Press the L key; the clip starts playing in the Source Monitor. Now, press the K key 
at 00:00:00:29 frame, where the clip starts showing the waterfall; the clip is paused. 
Alternatively, you can type 00:29 in the current time display field to jump to that frame.

3.	 Choose the Set Marker (Num *) button in the playback controls of the Source 
Monitor; an unnumbered marker is set to that frame. Also, an icon is displayed 
above the time ruler, refer to Figure 3-14. 

Figure 3-14  The icon displayed above the time ruler

Note
To view the marker, you need to move the current-time indicator (CTI).

4.	 Press the L key to play the clip and press the * key on the numeric keypad where you need 
to set the unnumbered markers on the clip; the unnumbered markers are set, as shown 
in Figure 3-15.

Figure 3-15  The unnumbered markers

5.	 Choose the Go to Previous Marker or Go to Next Marker button to move the  
CTI to the previous or next marker, respectively. 

6.	 Move the cursor over the video clip in the Source Monitor. Press and hold the left mouse 
button over the clip and drag the clip to the Video 1 track in the Timeline; the unnumbered 
markers are displayed on the track, as shown in Figure 3-16. 

Figure 3-16  The unnumbered markers displayed in the Video 1 track
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Note
You need to press the BACKSLASH (\) key on the keyboard to view the markers in the Video 1 
track. 

7.	 Select the water fall.AVI clip in the Timeline panel and press the DELETE key to delete 
this clip.	

Setting the Numbered Markers 
1.	 In the Project panel, double-click on the sea view(1).AVI clip; the clip is displayed in the 

Source Monitor. 

2.	 Press the L key; the clip starts playing in the Source Monitor. Now, press the K key at 
00:00:03:03 frame; the clip is paused and displayed in the Source Monitor, as shown in 
Figure 3-17.

Figure 3-17  The view at 00:00:03:03 frame

3.	 Choose Marker > Clip Marker > Set Other Numbered from the menu bar; the Set 
Numbered Marker dialog box is displayed, as shown in Figure 3-18.

4.	 Make sure that 0 is entered in the Set Numbered Marker edit box and choose the OK 
button; a marker is set at 00:00:03:03 frame. Also, an icon is displayed.

5.	 Again, press the L key to play the clip and press the K key at 00:00:12:17 frame; the clip 
is paused.
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Figure 3-18  The Set Numbered Marker dialog box

6.	 Choose Marker > Clip Marker > Set Next Available Numbered from the menu bar; 
another numbered marker is set at 00:00:12:17 frame. 

7.	 Similarly, set the numbered markers at 00:00:18:01 and 00:00:20:28 frames.

 	 You can view numbers on the numbered markers only when you drag the clip to the 
Timeline.

8.	 Move the cursor over the video clip in the Source Monitor. Press and hold the left mouse 
button over the clip and drag the clip to the Video 1 track in the Timeline; the numbered 
markers are displayed on the track as 0,1,2, and 3, as shown in Figure 3-19. 

Figure 3-19  The numbered markers displayed on the video track

Setting the In and Out Points in the Source Monitor
If you want to use only a part of the video clip in your sequence then you need to trim that part 
from the clip. The first frame of that trimmed clip is known as the In point and the last frame 
of that trimmed clip is known as the Out point. In this section, you will learn how to set the 
In and Out points in the Source Monitor to use a particular part of the clip in the sequence.

1.	 Make sure that the sea view (1).avi clip is opened in the Source Monitor. The markers 
have already been set in the clip and displayed on the time ruler.

2.	 Press the L key; the clip starts playing in the Source Monitor. Next, press the K key at the 
first marker at 00:00:03:03 frame; the clip is paused.

3.	 Choose the Mark In button from the playback controls of the Source Monitor; an  
icon is created similar to the open bracket on the time ruler to specify the In point.  
You need to move the CTI to view the icon. 

4.	 Choose the Go to Next Marker button; the CTI is moved to the next marker at 
00:00:12:17 frame. Next, choose the Mark Out button; another icon is created 
similar to the closed bracket on the time ruler to specify the Out point. The area 
between the In and Out points is highlighted, as shown in Figure 3-20. Also, the 
total duration of the trimmed clip (00:00:09:15) is displayed on the top right of 
the time ruler, refer to Figure 3-20.
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Tip. Press the I or O key on the keyboard to set the In or Out point, respectively in the time 
ruler of the Source Monitor. 

Figure 3-20  The trimmed clip highlighted

	 Choose the Play In to Out button to play the trimmed clip in the Source 
Monitor. To play the trimmed clip in a loop, choose the Loop button and 
then choose the Play In to Out button. To move the CTI to the In or Out 
point, choose the Go to In or Go to Out button, respectively. 	                                                                                     

Tip. Press the Q or W key on the keyboard to move the CTI to the In or Out point, 
respectively.

	 If you need to change the In or Out point, then move the CTI to the required frame and 
choose the Mark In or Mark Out button again. To remove the In or Out point, press and 
the ALT key on the keyboard and choose the Mark In or Mark Out button, respectively. 
To remove the In and Out points simultaneously, press G.  

Adding Clips to the Sequence 
Once you have viewed and trimmed the required part of the video clip by specifying the In 
and Out points, you need to add the trimmed clip to the sequence.

1.	 Clear the Timeline and then make sure that the sea view (1).avi clip is opened in the Source 
Monitor. Also, the In and Out points are set in the clip based on your requirement.

2.	 Move the cursor over the Source Monitor. Press and hold the left mouse button and drag 
the clip from the Source Monitor to the compatible track in the Timeline. Next, release 
the left mouse button at the beginning of the Timeline; the clip is placed in the sequence, 
as shown in Figure 3-21. Also, it is displayed in the Program Monitor, refer to Figure 3-21. 
Since this video clip has both audio and video components, the video is placed on the 
video track and the audio is placed on the corresponding audio track. Since the clip has 
Mono audio, it is placed on the Audio 4 track.

3.	 In the Project panel, double-click on the road drive (5).AVI clip; it is displayed in the 
Source Monitor, as shown in Figure 3-22.
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Figure 3-21  The clip placed in the sequence and displayed in the Program Monitor

Figure 3-22  The road drive (5).AVI clip in the Source Monitor
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4.	 Press the L key to play the clip and press the K key when the CTI reaches to the 00:00:02:28 
frame; it is paused at that frame.

5.	 Choose the Mark In button at 00:00:02:28 frame; an icon is created, which specifies the 
In point.

6.	 Again, press the L key to play the clip and press the K key when the CTI reaches to the 
00:00:14:11 frame; the clip pauses at this frame.

7.	 Choose the Mark Out button at 00:00:14:11 frame; an icon is created, which specifies 
the Out point. Also, the area between the In and Out points is highlighted, which 
specifies the trimmed clip, refer to Figure 3-23. The total duration of the trimmed clip is 
00:00:11:14. 

Figure 3-23  The highlighted trimmed clip

	 Next, you need to add this clip just after the first clip in the Timeline.

8.	 Move the cursor over the clip in the Source Monitor. Press and hold the left mouse button 
and drag the clip from the Source Monitor to the Timeline just after the first clip. When 
you drag the clip, its edges snap to the first clip and with the CTI. Also, its edges get 
aligned with that of the first clip, refer to Figure 3-24. Next, release the left mouse button; 
the second clip is placed just after the first clip in the sequence.

Figure 3-24  The second clip aligned with the first clip 

Note
By default, the Snap button on the top left of the Timeline is chosen to make the snap 
feature available. You can deactivate this button to make snap feature unavailable. 

	 When you drag the video clip from the Source Monitor to the Timeline for assembling 
a sequence, the video and audio get linked together and both will be displayed on the 
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corresponding tracks. If you need to add only the video or the audio to the sequence, you 
need to follow the steps given below:

	 To add only the video of the clip, move the cursor over the Drag Video Only button  
in the Source Monitor and drag it to the Timeline on the video track. Only the 
video of the clip is added to the sequence.

	 To add only the audio of the clip, move the cursor over the Drag Audio Only 
button in the Source Monitor and drag it to the Timeline on the audio track. Only 
the audio of the clip is added to the sequence.

9.	 Press CTRL+S keys to save the file.	

Adding Clips Using the Overlay and Insert Edits
In the previous section, you learned how to add clips to the empty part of the track in the 
Timeline. You can also add clips over the already placed clips or between the clips. To do so, 
you need to perform the Overlay and Insert edits. 

Working with the Overlay Edit
In the Overlay edit, the new clip overlaps the already placed clips in the Timeline without 
shifting the frames in the tracks. Also, the Overlay edit does not change the total duration of 
the sequence, but it changes the duration of any clip in the Timeline if it gets overlapped by 
the new clip being added. In this section, you will learn how to perform the Overlay edit.

1.	 First, open the chapter03_overlay_insert_edits.prproj file that you have downloaded from the 
CADCIM website. Two clips are already placed in the sequence.

2.	 Choose File > Save As from the menu bar; the Save Project dialog box is displayed. Browse 
to \Documents\Adobe Premiere Tutorials. Type chapter03_overlay_insert_2 in the File name 
text box and choose the Save button; the opened file is saved with the specified name.

3.	 In the Project panel, double-click on the road side view (3).AVI clip; it is opened in the 
Source Monitor.

4.	 Set the In and Out points as discussed earlier. 	
	
5.	 Press and hold the left mouse button over the Source Monitor and drag the clip to the track 

in the Timeline to the edit point of the first and second clips, which are already placed in 
the Timeline, refer to Figure 3-25. Note that while dragging the clip to the Timeline, the 
Program Monitor displays the current duration and view of the first and second clips, refer 
to Figure 3-26. Next, release the left mouse button; the new clip is placed in the Timeline. 
Also, the duration of the first and second clips is reduced according to the overlapping 
area. However, the total duration of the sequence is not changed. 

6.	 Press CTRL+Z to undo the last step.
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Figure 3-25  The road side view (3) clip dragged at the edit point of the 
first and second clip

Figure 3-26  The current duration of the second clip in the Program Monitor 



Assembling Sequences in the Timeline		        3-17

E
va

lu
a

ti
on

 C
op

y.
 D

o 
no

t 
re

pr
od

uc
e.

 F
or

 i
nf

or
m

a
ti

on
 v

is
it

 w
w

w
.c

a
dc

im
.c

om

Working with the Insert Edit
In the Insert edit, the new clip shifts the already placed clips on the track to make room for 
itself. Also, the Insert edit changes the total duration of the sequence but it does not change 
the duration of any clip in the Timeline. In this section, you will learn how to perform the 
Insert edit.

1.	 In the Project panel, double-click on the road drive (5).AVI clip; the clip opens in the 
Source Monitor.

2.	 Set the In and Out points as discussed earlier, based on your requirement. 

3.	 Press and hold the left mouse button over the Source Monitor and drag the clip between 
the first and second clips in the Timeline; the shape of the cursor is changed, as shown 
in Figure 3-27. Next, press the CTRL key; the vertical line is displayed with forward 
arrows on it, as shown in Figure 3-28. These arrows indicate the tracks in which the clips 
will be shifted in the Timeline. Now, release the left mouse button; everything after the 
insertion point shifts forward to make room for the new clip. Also, the new clip is placed 
in between the first and second clips, refer to Figure 3-29. Note that the total duration of 
the sequence is increased in this process.

Figure 3-27  The cursor displayed after placing the 
cursor between the clips 

Figure 3-28  The vertical line with forward arrows

4.	 Press the SPACEBAR to view the sequence; the clip starts playing in the Program 
Monitor.

	 You can also split an existing clip by using the new clips. To do so, you need to follow the 
steps given below:

5.	 In the Project panel, double-click on the road drive (2).AVI clip; it is opened in the Source 
Monitor.
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Figure 3-29  The new clip placed between the two clips

6.	 Set the In and Out points based on your requirement. 

7.	 Press and hold the left mouse button over the Source Monitor and drag the clip in the 
middle of the sea.view.AVI clip in the Timeline. Next, press the CTRL key; the vertical 
line is displayed with forward arrows on it, as shown in Figure 3-30. Next, release the 
left mouse button; the sea.view.AVI clip is split into two parts and the second part is 
forwarded in the Timeline. Also, the new clip is placed in the middle of the two parts, 
refer to Figure 3-31.

Figure 3-30  The cursor in the middle of the sea view.AVI clip

Figure 3-31  Partial view of the track after placing 
the new clip in the middle of the sea view.AVI clip

8.	 Press the SPACEBAR key to view the sequence; the clip starts playing in the Program 
Monitor.
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Using the Toggle Sync Lock and Toggle Track Lock Buttons
In a typical video editing project, you may have multiple tracks of video and audio clips in the 
Timeline. While performing the Insert or Ripple edits, if one track shifts, all other tracks will 
also shift. However, sometimes you may not want to shift a particular track. In such a case, you 
can protect one or more tracks from being moved by using the Toggle Sync Lock and Toggle 
Track Lock buttons. In this section, you will learn how to use these buttons.

1.	 In the Project panel, double-click on the water fall.AVI clip; the clip opens in the Source 
Monitor.

2.	 Set the In and Out points based on your requirement. 

3.	 Move the cursor over the Drag Video Only button in the Source Monitor and drag 
it to the Timeline in the Video 2 track; the video portion of the clip is displayed 
on the Video 2 track, as shown in Figure 3-32. 

Figure 3-32  Partial view of the Video 1 and Video 2 tracks

4.	 Expand the Video 2 track by choosing the Collapse-Expand Track button in the 
Timeline, refer to Figure 3-32.

	 Next, you need to insert a new clip in the Video 1 track in such a way that the clip in the 
Video 2 track will not be affected by the Insert edit.

5.	 In the Project panel, double-click on the sea view (2).AVI clip; the clip opens in the Source 
Monitor.

6.	 Set the In and Out points based on your requirement.

7.	 In the Video 2 track, choose the Toggle Sync Lock button; the button now becomes 
unavailable.  

8.	 Move the cursor over the Drag Video Only button in the Source Monitor and drag it to the 
Timeline in the Video 1 track in the middle of the sea view (1) clip, refer to Figure 3-33. 
Next, press the CTRL key; a vertical line is displayed with forward arrows on it, refer to 
Figure 3-34. Note that the vertical line does not display any arrow on the Video 2 track. 
Next, release the left mouse button; the new clip shifts the other clips forward in the 
Timeline and it is placed in the middle of the sea view (1) clip in the Video 1 track. Also, 
the clip in the Video 2 track is not affected by the Insert edit, refer to Figure 3-35. 

 9.	 In the Video 1 track, choose the Toggle Track Lock button; this button becomes 
available now. Also, diagonal lines display through the track, as shown in Figure 3-36. 
Next, try to insert a new clip in the Video 1 track. You will notice that you cannot 
perform any action in the Video 1 track. 
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Figure 3-33  The cursor in the middle of the sea view (1) clip in the Video 1 track

Figure 3-34  The vertical line with arrows displayed on pressing the CTRL key 

Figure 3-35  The new clip inserted in the Video 1 track 

Figure 3-36  Diagonal lines in the Video 1 track

Working with the Three-Point Overlay and Insert Edits 
In the earlier sections, you learned how to add clips to the sequence by drag and drop method. 
You can also add clips to the Timeline using the editing buttons in the playback controls of 
the Source Monitor. This method is known as three-point editing. In this section, you will 
learn how to perform the Overlay and Insert edits using editing buttons.

1.	 First, open the chapter03_overlay_insert_edits.prproj file that you have downloaded from the 
CADCIM website. Two clips are already placed in the sequence.

2.	 Choose File > Save As from the menu bar; the Save Project dialog box is displayed. Browse 
to \Documents\Adobe Premiere Tutorials. Type the name chapter03_three_point_edit in the 
File name text box and choose the Save button; opened file is saved with the specified 
name.

3.	 In the Project panel, double-click on the sea view (2).AVI clip; the clip opens in the Source 
Monitor.
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4.	 Set the In and Out points based on your requirement.

5.	 In the Timeline, set the CTI at a position where you want the starting point of the new 
clip, refer to Figure 3-37. 

Figure 3-37  The CTI set over the clip

6.	 Choose the Overwrite button in the playback controls of the Source Monitor to 
perform the Overlay edit; the new clip is placed in the sequence. Also, the CTI is 
moved to the end of the new clip, as shown in Figure 3-38. Next, you will perform 
the Insert edit using the editing buttons.

Figure 3-38  The CTI placed at the end of the new clip
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7.	 Move the CTI to the end of the first clip and at the starting point of the second clip, refer 
to Figure 3-39.	

Figure 3-39  The CTI set in the Timeline

8.	 In the Project panel, double-click on the sea.AVI clip; the clip opens in the Source 
Monitor.

9.	 Set the In and Out points based on your requirement. 

10.	 Choose the Insert button in the playback controls of the Source Monitor; the new 
clip is inserted, shifting the other clips forward in the Timeline, refer to 
Figure 3-40. 	

Figure 3-40  The new clip inserted 
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Note
You can also press the period (.) key for performing the Overlay edit and the comma (,) key for 
performing the Insert edit.  

 Self-Evaluation Test 
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Which of the following shortcut keys are used to invoke the Import dialog box?
	
		  (a) I					     (b) CTRL + I
		  (c) SHIFT + I				    (d) CTRL + SHIFT + I

2.	 Which of the following buttons is used to create a new bin in the Project panel? 

		  (a) New Item 	 			   (b) Icon view
		  (c) New Bin	 			   (d) None of these

3.	 Which of the following shortcut keys is used to perform the Overlay edit?
	
		  (a) Period (.)	 			   (b) Comma (,)
		  (c) I					     (d) O

4.	 Which of the following shortcut keys is used to perform the Insert edit?
	
		  (a) Period (.)	 			   (b) Comma (,)
		  (c) I					     (d) O

5.	 The first frame of a trimmed clip is known as the ________ point and the last frame of 
that trimmed clip is known as the ________ point.

6.	 To remove the In or Out point, press the ALT key and choose the ________ or _______ 
button, respectively.

7.	 To view the marker, you need to move the current-time indicator. (T/F)

8.	 The Drag Video Only button in the Source Monitor is used to add only the video of the 
clip to the Timeline. (T/F)

	
9.	 In the Overlay edit, the new clip overlaps the already placed clips in the Timeline and 

shifts the frames in the tracks. (T/F)

10.	 The Insert edit changes the total duration of the sequence, but it does not change the 
duration of any clip in the Timeline. (T/F) 
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 Review Questions 
Answer the following questions:

1.	 Which of the following buttons is used to protect one or more tracks from being moved 
while performing the Insert edit?

	
		  (a) Toggle Track Lock 		  	 (b) Toggle Sync Lock
		  (c) Collapse-Expand Track		  (d) None of these

2.	 Which of the following buttons is used to collapse or expand the tracks in the Timeline? 

		  (a) Toggle Track Lock 		  	 (b) Toggle Sync Lock
		  (c) Collapse-Expand Track		  (d) All

3.	 Which of the following buttons in the Source Monitor is used to perform the Overlay 
edit? 

	
		  (a) Insert				    (b) Overwrite 
		  (c) Set In Point	 			   (d) Set Out Point

4.	 In the Source Monitor, you can control playback, specify edit points, trim the video clip, 
and specify some more viewing options. (T/F)

5.	 The speed of playback depends on how far you drag the Shuttle slider. (T/F) 

6.	 The Overlay edit does not change the total duration of the sequence, but it changes the 
duration of any clip in the Timeline. (T/F) 

7.	 Press the ________ key to play the clip forward. Press the _________ key to play the clip 
backward and press the __________ key to pause the clip.

 Exercise 

Exercise 1
Create a new project in Premiere based on the settings of your video clip. Import your video 
clips in the Project panel. Try to set the In and Out points in the clips in the Source Monitor. 
Also, perform the Insert and Overlay edits using the shortcut keys on the keyboard.

Answers to Self-Evaluation Test
1. b, 2. c, 3. a, 4. b, 5. In, Out, 6. Mark In, Mark Out, 7. T, 8. T, 9. F, 10. T


